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STANFORD ELECTRONIC RESEARCH ADMINISTRATION
My Dashboard

My Dashboard is your home page of in the SeRA system. Once you log-into SeRA you are directed to the My
Actions Items tab on My Dashboard. My Action Items lists all the transactions assigned to you and require your
action to complete, review or approve.

Stanford University | SeRA Search: ” 1 AMIDDLET  Log Out
# Home > 1 Transaction ID/PDRF #
Agresment &
My Dashboard Agreement® .
=+ Initiate New Proposal 2 3 Advanced Search
Wil Reports 7 ~

My ActionItems My Projects  Pipeline  Proposals My Accounts
& Subawards 8

& eCertification 9

& oracs 10

' IDC Waivers 11

My Action Items

Listed below are all of the Items that are currently assigned to you for action. Click on the blue link in the first column to open your Action Ttem.
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1 - Search

Use the pulldown menu to select the criteria you want to search by, type the reference number in the text box and
hit the “enter” key to start searching. Select the Advanced Search option to search by more than one criteria.

2 — +Initiate a New Proposal

Click here to start a new Proposal Development Routing Form (PDRF) a web-form which captures proposal
information, attachments and routes electronically to the PI, other faculty, reviewers and approvers.

3 -Tabs
* My Action Items - lists My Actions which require you take action and complete. The SeRA “to do list”
e My Projects - allows you to view the research project portfolio of faculty you support
* Pipeline - lets you see transactions you worked on, but now assigned someone else for further action
* Proposals - lists all of the proposal action items assigned to you and await your action
* My Accounts - presents a financial snapshot of research projects for a selected principal investigator
4 - Search by column

Narrow down your search of My Action ltems by searching by selecting a specific column-field name, typing your
search criteria in the text box and clicking the “Go” button.
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STANFORD ELECTRONIC RESEARCH ADMINISTRATION

My Dashboard

5 — Actions menu button

Actions ~

[ Select Columns Allows user to choose which columns to display

Y Filter Allows user to display items based on specific criteria

E RowsPerPage > Allows user to select how many items to display per page

¥ Format > Allows user to customize the display of the attachment list

[1 SaveReport Allows user to save customized formatted display

{0 Reset Allows user to reset the items list to original format

(7) Help Detailed help on the various functions

4. pownload Allows user to download the display to Excel or HTML format

6 — Column - field names

Each Action Item is designated an ID#, SPO# and descriptive column labels. Click on the columns labels to
sort up or down, hide columns or group Action Items by the column basis of your choice.
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ID# - the unique SeRA transaction identification number for each SeRA transaction.
Process Type - a description of the process which the Action Item falls under.
Action Item - a description of the task required to fulfill the Action Item.

SPO# - acronym for Sponsored Projects Office number. The unique identification number for
each sponsored research project at Stanford University.

Pl - acronym for Principal Investigator. The lead researcher who directs and oversees technical
and administrative components of a sponsored research project.

Sponsor - entity providing financial and/or technical support for a sponsored research project.
Project Title - Brief statement which names and describes the research project.

Days Assigned - number of days the Action Item has been assigned to current you.

Days Open - number of days the Action Item has existed.

Status - the state of the Action Item. When in My Action Items always “In Progress”.

Flag - optional function for user to prioritize by clicking on the flag icon.



STANFORD ELECTRONIC RESEARCH ADMINISTRATION

My Dashboard

7 - Reports

e Other Support - General - report reflecting faculty’s funding support from proposed and
awarded sponsored awards in a non-sponsor specific format.

e Other Support - NIH report reflecting faculty’s funding support from proposed and awarded
sponsored awards in the NIH specific format.

* Project List - report of projects by SPO# generated by the user’s desired search criteria

e Dept Proposal Submissions - report of proposals for the user’s department owning organization
code for a specified period of time based on proposal submission dates.

8 — Subawards
Link to SeRA sponsored research subaward database
9 - eCertification

Link to eCertification website for quarterly certification tracking and reviewing, certifying and monitoring of
payroll distribution.

10 - OPACS

Link to the Outside Professional Activities Certification System (OPACS) for faculty to certify their
compliance with the Faculty Policy on Conflict of Commitment and Interest.

11 - IDC Waivers

Link to the Office of the Dean of Research’s website for the pre-approved indirect cost (IDC) exception list
and project specific waiver request page.

12 - Cayuse 424

Link to the Stanford’s Cayuse 424 web-based proposal development and submission system.
13 - User Guides

Link to SeRA User Manuals/Guides on the DoResearch—SeRA webpage.

14 - Help Request (HelpSU)

Link to initiate a HelpSU ticket to report technical issues related to the SeRA system.
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STANFORD ELECTRONIC RESEARCH ADMINISTRATION

Project Summary Page

This is the Project/SPO# home page. From this page you can view active transactions, submitted proposals,
awards received, and NOAs. You can also view project history, view and manage attachments, and initiate
transactions.

# Home ~ Project Summary

Biology Department Agreement type: Grant

William J Nelson Agreement Number: RO1 GM035527 Sponsor: National Institutes of Health
Attachments

y Pr I A | d Other Transactions

R 4 5 6 7

Project Comments

O View Latest NOA

Al Reports 2
Title Topogenesis of NA/K-ATPASE in Polarized MDCK Epithelial Cells View Latest PDRF
@ Subawards ped o 1 O
Keyword Topogenesis of Na+K+ ATPa
&' eCertification
Start Date 07/01/1990 Total Project Estimated Cost §14,786,228,00
& OPACS Funded To Date 03/31/2016 Total Project Funded To Date §13,959,049.00

' IDC Waivers 1

' Cayuse 424

—
—
[}

B User Guides hd
Segment

e Help Request(HelpSU) A\lnrllSegmeﬂl@) Sequence Number Type Start Date End Date Budget Amount Funded To Date Funding Status
51 1 New 07/01/1950 03/31/15995 § 1,188,251.00 § 1,188,251.00 Fully Funded
52 2 Renew 04/01/1995 03/31/1999 $ 1,573,55L.00 $ 1,573,551.00 Fully Funded
53 3 Renew 04/01/1999  03/31/2003 § 1,921,229.00 § 1,921,229.00 Fully Funded
54 4 Renew 04/07/2003 03/31/2007 $ 2,176,851.00 $ 2,176,851.00 Fully Funded
S5 5 Renew 04/01,/2007 03/31/2008 §  555,226.00 § 55522600 Fully Funded
S6 6 Supplernent  02/01/2005 03/31/2008 $  161,269.00 $ 161,269.00 Fully Funded
57 7 Renew 04/01/2008 03/31/2013 $ 3,565,024.00 $ 3,565,024.00 Fully Funded
58 Supplernent  09/01/2008 04/30/2010 § 131,735.00 § 131,735.00 Fully Funded
9 9 Renew 07/11/2008 03/31/2010 S 60,205.00 $  60,205.00 Fully Funded
510 10 Supplernent  12/01/2008 03/31/2010 §  61,796.00 $  61,796.00 Fully Funded
s11 1 Supplernent  04/01/2008  03/31/2013 S 8555611.00 § 639,611.00 Partially Funded
Segment- 12 12 Renew 04/01/2013 03/31/2018 § 253548000 § 1,924,301.00 Partially Funded

N

1-3
ProposalID  Deadline Date Proposal Type StartDate  EndDate  AmountRequested  Status
P32 15-Feb-2016 05:00PM MNon-competing Continuation/Progress Report  04/01/2016 ~ 03/31/2017 L3 611,179.00 Proposed / Submitted
P31 15-Feb-201505:00PM Men-competing Continuation/Progress Report 04/01/2015 03/31/2016 3 620,868.00 Proposed / Submitted
P23 15-Feb-2012 05:00PM MNon-competing Continuation/Progress Report  04/01/2012  03/31/2013 L3 896,545.00 Proposed / Submitted

w

Assigned to Transaction Date Assigned  Transaction Id Status Last action date

Last Completed Lorede, Robert Proposal - Non Competing Continuation/Progress Report 02/12/2016 PR633121 Completed 02/12/2016

11
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STANFORD ELECTRONIC RESEARCH ADMINISTRATION

Project Summary Page
1 - Award Segments

Shows all award segments. The first Segment results from the original new proposal, and subsequent segments can
result from renewals and supplements if they are not merged with an existing segment at the time of award.
Merging typically occurs when the sponsor’s renewal or supplemental award does not require the new funds to be
accounted for separately. If the sponsor does require funds to be accounted for separately, the award will be made
as a new Segment. New award segments will usually result in a new Oracle Award.

2 — Submitted Proposals Pending Award

Shows all submitted proposals that are pending the sponsor’s decision. If the proposal was marked as awarded,
withdrawn or rejected it will not appear in this section.

3 - Open & Last Completed Transactions

Any open activities associated with this SPO# that are occurring within the SeRA system will appear in the Open
section. Authorized users can click the Transaction name to view the details of the transaction. Users can also view
the Last Completed transaction associated with this SPO#.

4 — Proposals Tab
Click to view a list of all proposals submitted under this SPO#. Individual proposals can be access from this tab.
5 - Awards Tab

Two views are available under this tab:

> Segment View: displays the funding summary by segment and the funding status of budget periods within
each segment.

» Transaction View: lists all award transactions posted to this SPO#.
6 — Subawards Tab
Displays subawards and related information issued under this SPO#.
7 — Other Transactions Tab

Click to view a list of all other non-proposal and non-award transactions processed under this SPO#. Includes old
converted SPO/RMG log transactions.

8 - Project Level Navigation

» Attachments: Click to view all attachments associated with this SPO#. This will include all proposal/PDRF
attachments, award documents, and other associated files.

» Personnel: Click to view a list of the PI and Other Stanford Faculty associated with this project. Authorized
users will also have access to view each faculty member’s OPACS disclosure history relative to this project.

» Project History: Click to view a list of all transactions associated with this SPO# (includes legacy converted
SPIDERS transactions).

9 - View Latest NOA

Click to view the latest NOA issued under this project.

10 - View Latest PDRF

Click to view the latest Proposal Development and Routing Form.

11 - Start a Transaction at the Project Level

Authorized users can initiate a Proposal-Renewal PDRF or an Early/Extended Account Request for this project.
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STANFORD ELECTRONIC RESEARCH ADMINISTRATION

Basic Sponsored Project Lifecycle Transactions

Prepare NEW PROPOSAL record Pl Approval Institutional Review

Approved Proposal Record

Correct Proposal

Withdraw Proposal

Reject Proposal

[

Proposal Revision

Proposal Resubmission

JIT Request

Transfer Proposal

Process Award - New

Account Set-Up: New

Approved Award Record

Sponsor Notification

PROJECT
Sponsor Request

Proposal — Competing Renewal

Subaward New/Change Order

Account Set-Up: Amend

Process Award - Amendment

Account Set-Up: Early/Extend
\_ Account Set-Up: Amend

Process Proposal - Supplement

L

Process Award — Supplement

\_ Account Set-Up: Amend

Process Proposal — NCC/Progress Rpt

L

Process Award — NCC/Progress/Rpt

\_ Account Set-Up: Amend

Correct Award
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STANFORD ELECTRONIC RESEARCH ADMINISTRATION

Attachments

Categories and Sub-Categories viewable by Departments and Pls

* R/

%+ Proposal Documents o
Proposal — New

Proposal — Resubmission
Proposal — Supplement

Proposal — Renewal

Proposal — Non-Competing
Continuation o
Abstract

Statement of Work

cv

Just-In-Time Documents

VVVVY

O VVVYyY

etailed Budget and Justification
Budget — New

Budget — Resubmission

Budget — Supplement o
Budget — Renewal

Budget — Non-Competing
Continuation

Budget — Draft

Budget — Revised

Justification

VVVVY

>
>
>

<*Waiver
> Pl
> IDC
> Pl Effort

Agreements & NOAs X
Agreement — New/Original
Agreement — Amendment

NOA - New/Original Award

NOA - Amendment

NOA - Administratively Issued

O VVVVYVY

ompliance Document
IRB

APLAC <
SCRO

SRC

Export Control

Conflict of Interest

Other .

0’0

ubaward Documents
Agreement — New
Agreement — Amendment
Requisition

Statement of work
Detailed Budget
Budget Justification

T VVVVVVVY VVVVYVYVY

roject Management
Closeout Documents
Cost Sharing Budget

Dept Financial Reports

General Correspondence

Other

Other Agreements

PTA Budget Allocation Information
» PTA Set-Up Information

Payment Requests/Notifications

Sponsor Guidelines

YVVVVYVYVYVYY

\ 4

Clinical Trial Documents

Budget — Internal
Budget — External
Budget — final, Internal
Budget — final, External
LOI

Investigator Agreement
Certificate of Insurance

VVVVYYVYY

Non-Financial Report
» Technical - Interim
» Technical - Final

> Invention

> Property

Zero-Dollar Agreements

» Agreement — New
» Agreement — Amendment

Subrecipient Commitment Form — Form 33

Cost Sharing Commitment/Funding Info

Tip: The SeRA attachment interface merges files from 2 different sources:

1) Files that were attached via SeRA

Progress Report-08689-20110128.pfif

2) Historical files in a document library previously used by RMG

and OSR

8689-AGA-1-VOL-4.pdf

8689-AGA-4-VOL-4.pdf

Only files attached via SeRA are viewable by departmental users.

Filename Updated By
MTECSON
SYSTEM

SYSTEM

How can I tell? Check the Updated By field, if the field is entirely in uppercase letters, departmental users will
see garbled text in lieu of the actual file content.



STANFORD ELECTRONIC RESEARCH ADMINISTRATION

Attachments

Stanford University | SeRA

Click on # Home

Attachments ' _

to access the

Attachments FroiectumTeny

page for this

pI’OJECt Personnel Surmmary
Project Comments
Project History

Project Attachments

Project Summary

“ SPO #8689
William J Melson

Biology Department Agreement type: Grant

Summary  Proposals Awards Subawards

Project Summary

Agreement Number: R01 GMO35527

Other Transacti

Add New Attachment

Files, categories & subcategories denoted by an asterisk are only viewable by Central Office users. View Attachment Restrictions.

Q. Go Rows
Proposal Segment
Category Subcategory Identifier  Identifier
Proposal -
Proposal Mon-Competing P32 -
Documents . b
Continuation
Proposal -
e Non-Competing P32 =
Documents . h
Continuation
Agreements Agreement - 12
& NOAs Amendment
Proposal -
Proposal Non-Competing P31 =
Documents . -
Continuation
Proposal -
Proposal Non-Competing P31 -
Documents . .
Continuation
Agreements Agreement - 12
& NOAs Amendment

All

= Actions
Rev Updated
Filename File Tags # On

eRA Commens RPPR for Grant ROLGMO035527-32 1 02/12/2016

Submitted to Agency.msg 04:51 PM
02/12/2016

NCC-8689-20160215. pdf 2 04:37 PM
03/24/2015

AGRMMNT-A31-8689, pdf 1 09:03 AM
Re-submission confirmation- 1 02/12/2015

8689-20150212.msg 12:39 PM
02/11/2015

NCC_#689_20150211.pdf 1 1125 AM
05/20/2014

AGRMNT-A30-8689. pdf 1 11:29 AM

Updated
By

Loredo,
Robert

Aranya,
Irene

Corvo,
Cristina

Loredo,

Robert

Hu, Jenny

Hsu, Flora



STANFORD ELECTRONIC RESEARCH ADMINISTRATION

Attachments

Useful features available from the Actions menu

mjsehgct Columns Allows user to choose which columns to display

VFilter Allows user to display attachments based on specific criteria

= Rows Per Page Allows user to select how many attachments to display per page
%Format Allows user to customize the display of the attachment list
®Flashback Allows user to view the data as it existed at a prior point in time.
N Save Report Allows user to save customized formatted display

CQReset Allows user to reset the attachments list to original format
@Help Detailed help on the various functions
lin Download Allows user to download report to Excel or HTML format

10



STANFORD ELECTRONIC RESEARCH ADMINISTRATION

Attachments

Customize Your View: Display Columns

Actions ™
m From the Actions menu, choose
the “Select Columns” option to
Y Filter pick which columns you prefer
to display.
= Rows Per Page >
Select Columns X
Do Not Display Display in Report
I 1D# i $
Process Type
» Action Item i T
> |SPO# (e
¢ g:mnsm 0 Click to
< |Project Title A app Iy your
_| A |DaysAssigned _ cha nges
Cancel
Use these buttons to control which columns are Use these buttons to control the order in
displayed or hidden which the columns appear on your screen
EH reset to default @ Move to top
3» move all to the right G Move up one
» move only the selected to the right @ Move down one
@ move only the selected to the left & Move to bottom

@g move all to the left

Tip: Press the Ctrl key to select multiple columns at once



STANFORD ELECTRONIC RESEARCH ADMINISTRATION

Attachments

Customize Your View: Rows Per Page

From the Actions menu, choose

Actions v y ) )
Rows Per Page” to pick the

M select Columns number of attachments to display
Y Filter
2, Format M2

10
l:l Save Report
CQ Reset 1

20
@Help

25
Y, Download

50

100

1000

® Al

12



STANFORD ELECTRONIC RESEARCH ADMINISTRATION
Attachments
Customize Your View: Sorting

Sorting allows the user to put the attachments in ascending or
descending order based on column contents. There are 2 ways to sort:

o Click on a Column header to
quick sort by a single column

Q Filter...

Compliance Document
Detailed Budget & Just...
Notification / Request

Program Guidelines

Proposal Documents

e Click on Actions and select Format
> Sort to sort by multiple columns

|. Actions |

Sort X

m]Select Columns — )
Column Direction Null Sorting

1 -Select Column- ~ Ascending =~ Default -
VFHter 2 -SelectColumn- - Ascending ~ Default -

3 -Select Column- ~ Ascending -~ Default -
g Rows Per Page ? 4 -Select Column- ~ Ascending ~ Default -

5 - Select Column - - Ascending ~ Default -
%Fnrmat ? ’P\LSDH: > 6 -Select Column- ~ Ascending =~ Default -

Cancel Apply
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Attachments

Customize Your View: Filtering

Filtering allows the user to show a subset of attachments based on
selected criteria. There are 2 ways to filter:

o Click on a Column header to quick
filter by a single column

(_ Filter...

Available options are based
on the actual files attached
to the Project Detailed Budget & Just...

Compliance Document

Notification / Request

Program Guidelines

Prousa! Documents

e Click on Actions and select Filter
to sort by multiple criteria

Actions v Filter

Filter Type ® Column © Row

[[I] Select Columns

Column Operator Expression
Category - = -

VFiIter > v
g I Agreements & NOAs El
> . . Compliance Document
LG JET Avallable OptIOnS are éDetailed Budaet & Justific.. ~
A Format > based on the actual p—

files attached to the
Project
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Attachments

Customize Your View: Searching

The Search functionality allows the user to find a specific file
based on a text search

o Search across all files by entering your criteria in the box
and clicking “Go”

Qv ows All *  Actions v

e Click on the magnifying glass Search Icon to limit your text
search to a specific column

Go Rows Al *  Actions v
All Columns
Category
Subcategory
Proposal Identifier
Segment Identifier
Filename
File Tags
Rev #
Updated On

Updated By



STANFORD ELECTRONIC RESEARCH ADMINISTRATION
Attachments
Customize Your View: Other Features

Removing Filters

Qv Go Rows All *  Actions v

v I Category = 'Subaward
Documents<b> </b>"

4 Subcategory = 'Detailed Budget<b>

</bs' \

Uncheck the box to enable or disable the filter Click the X to remove the filter entirely

Reset to default settings: Click = Actions™ and select  CQreset

Save settings for future use:

o Click = Actions™ and select Wsave Report

o Save Report X

Enter a name for these settings
Cancel @

(and a description, if desired) ==, -
and click Apply
e Qv Go | 1.Subaward Documents N |ng5 All v Actions ™

Description

v Saved Report = "Subaward Documents”

In the future, user can select the desired
saved report from the Reports menu (only
available if user has saved Reports)

\

Click the X to delete the saved settings entirely

el V Category = 'Subaward Documents<b> </b='

ual V Subcategory = 'Detailed Budget<b> </b>'



	Slide Number 1
	Slide Number 2
	Slide Number 3
	Slide Number 4
	Slide Number 5
	Slide Number 6
	Slide Number 7
	Slide Number 8
	Slide Number 9
	Slide Number 10
	Slide Number 11
	Slide Number 12
	Slide Number 13
	Slide Number 14
	Slide Number 15
	Slide Number 16

